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Abstract: 

  This study is about the use of Fuzzy Logic Toolbox in MATLAB for developing an expert system which able to 

give suggestion about nitrogen deficiency diseases of rice plant depending on various symptoms. The proposed expert system 

uses a collection of fuzzy membership functions and rules, instead of Boolean logic to reason about data. Fuzzy systems can be 

used for estimating, decision-making as well as mechanical control systems such as air conditioning, automobile control, and 

even smart houses, industrial process controllers, etc. This proposed expert system would assist farmer to understand soil nutrient 

disorder so that they can increase the rice production by taking right decision related to utilization of fertilizer. In present day 

world, expert system is widely used in agriculture. The main concept of Expert system development is to convert the domain 

knowledge of human expert into computerized form. 

 

Keywords: Expert system, agriculture, diseases, rice, Fuzzy Logic, MATLAB, BTAD, Nitrogen deficiency. 

 
INTRODUCTION: 

 Expert systems (ES) are computer programs, designed to make available some of the skills of an expert to non-experts. 

Since ES programs attempt to emulate the thinking patterns of an expert, it is natural that the first work was done in Artificial 

Intelligence (AI) fields. Among the first expert systems were the 1965 Dendral programs, which determined molecular structure 

from mass spectrometer data and MYCIN for medical diagnosis. Since the mid 1960s there have been many, many expert systems 

created for fields ranging from space shuttle operation through hospital intensive-care-unit patient monitoring to financial 

decision making. To create expert systems, it is usual to supply a development environment and possibly a run-time module; these 

are called expert system shells. The human knowledge are considered as declarative (fats we have in stored in memory) and 

procedural, skills in utilizing declarative knowledge to some purpose. 

 There are two general types of Fuzzy expert systems, which are, fuzzy control and fuzzy reasoning. Although both make 

use of fuzzy sets, they differ qualitatively in methodology. 

 BTAD is traditionally known as the area of paddy cultivation. For the people of BTAD, rice plays an important role in 

their socio-cultural life. Rice is the major food crop of Bodo Territorial Area Districts (BTAD) of Assam, mainly in chirang and 

kokrajhar districts in terms of production and consumer preferences. But paddy cultivation of BTAD often suffered by nutrient 

deficiency diseases due to its soil type (which is sandy loam to loam in average). Very few studies have been done on the 

relationship between available nutrients in the soil and various rice plant diseases in low land area like BTAD of Assam. 

The recent development in computer science and technology can help to upgrade the whole agriculture fields so that to get high 

yield. However, Expert Systems are relatively costly to design and develop but easy and can operate at very low cost. An Expert 

System can also automate many tasks that is not possible by a human expert to control effectively. The main concern of the 

proposed study is to design and development of an Expert System which give suggestion about nutrient deficiency and fertilizer 

management. 

 

ORIGIN OF RESEARCH PROBLEM: 

 In India, agriculture is the backbone of the country's economy and it is primary sector of the country. Farmers needed 

expert knowledge to take decision during soil preparation, seed selection, fertilizer management, etc. to increased agricultural 

production. But in the rural areas like BTAD, experts are not always available. So ES would be a powerful tool with extensive 

potential in agriculture, mainly for rural areas like BTAD. ES are cheaper compared to human experts in the long-term scenario. 

The proposed expert system can able to assistance to find proper nutrient deficiency of rice plants during cultivation. Nitrogen 

deficiency is one of the most common problems in rice in BTAD. 

 

METHODOLOGY: 

 

 Sampling sites had been be selected randomly from various rice fields of kokrajhar and chirang districts of BTAD. Soil 

samples had also collected from various rice fields randomly for testing nutrient status in soil. 

 As for the primary data, published and unpublished books, journals, articles had been considered by the researcher. 

Researcher had also considered online journals and articles about expert system and agricultural information regarding soil 

nutrient and rice plant diseases as a source of primary data. 
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As for the secondary data, the researcher had selected about 25 big rice fields and about 100 farmers in random basis from various 

rice fields of chirang and kokrajhar districts. 

 Data for rice plants diseases, especially Nitrogen deficiency diseases were gotten from the domain experts. In this 

process the principal investigator met few professor of botany as well as the Krishi Vigyan Kendra of Gossaigaon. Crisp values 

are transferred into fuzzy values through fuzzification. The fuzzy inference mechanism uses predicted value to diagnose the rice 

plant nutrient deficiency diseases. The mechanism was developed using MATLAB software and its fuzzy logic tools. 

 

LITERATURE REVIEW: 

 Application of Expert System in the field of Agriculture is not new. Numerous researches are being carried out. In 

Agricultural domain, applications of Expert System are mainly found in the area of diseases diagnosis and pest controls. 

YANG and OKRENT (1991) said that the most successful application of Artificial Intelligence in decision making so far 

in the development  of Decision Support System, particularly Expert System. Expert Systems are computer program that can 

arriving at particular decision like human experts on of his particular expert domain.   

Pinaki Chakraborti, Dr. Dilip Kumar Chakraborti (2008)[9] explain the success of Expert System for management of 

Malformation disease of Mango. 

Harvinder S. Saini, Raj Kumar and A.N. Sharma92002),discussed  about a web base fuzzy expert system for integrated 

pest management in Soybean in International Journal of Information technology(Vol. 8, No. 2,2002)[7]. 

G.N.R. Prasad, Dr. A. Vinaya Babu(2006)[9], are discussed about various agricultural expert systems. According to 

them, the modern farmer often approach to agricultural experts and advisor for decision making information. But expert help or 

assistance from agricultural specialist is not available all the time when farmer needs it. In this regard expert system help were 

identified as powerful tool with extension potential in agriculture. They also discussed about some more expert systems. 

A.J. Castro and Garcia – Torres (1995) [10], explains an expert system SEMAGI. An interactive microcomputer 

program named SEMAGI has been developed for sunflower to evaluate the potential yield reduction from multispecies weed 

infestations and from the parasitic weed broomrape and to determine appropriate selection of herbicide. It combines relational 

database on herbicides, weed and their interactions. SEMAGI provides an economic study of any herbicide treatment selected or 

introduced by the user, based on herbicide treatment cost, expected production increase from the weed control treatment and 

sunflower selling price. 

MINERAL NITROGEN: 

 The amount and number of elements present in plants may also differ from plant to plant, place to place and medium to 

medium in which the plants grow. All elements found in a plant are not essential for its growth and life cycle. A large number of 

them are non-essential. The list of essential macronutrient elements includes C, N, O, Ca, H ,K, Mg, P and S. These elements are 

required by the plants in major amounts. Of these ,N,P and K are considered as primary nutrients. 

 The chief source of nitrogen is the soil. And the soil type mostly found in kokrajhar and chirang districts are loamy and 

sandy loamy. For that reason soil cannot able to hold the nutrients. Most plants absorb nitrogen in the form of ammonium or 

nitrate. These forms readily dissolve in water and leach away with watering (either by rain or by cultivator) and the essential 

nutrients washed away insight the soil and lost forever. That is why nitrogen deficiency diseases in rice plants are common in 

kokrajhar and chirang districts of BTAD. 

NITROGEN DEFICIENCY SYMPTOMS: 

 In absence or low supply of nitrogen the following symptoms developed. 

(i) Older leaves or whole plants are yellowish green. 

(ii) Old leaves and sometimes all leaves become light green and chlorotic at the tip. 

(iii) Entire field may appear yellowish. 

Check the leaves for symptoms. Leaves can die under sever nitrogen stress. Except for young leaves, which are greener leaves of 

nitrogen deficient plants are narrow, small, short, erect and lemon-yellowish green. 

 
 

Figure 1: Nitrogen (N) deficient crops have low yield. 

 

 

MATLAB:  

MATLAB (short for MATrix LABoratory) is a special-purpose computer program optimized to perform engineering and 

scientific calculations. It stated life as a program design to perform matrix mathematics, but over the years it has grow into a 

flexible computing system capable of solving essentially any technical problem
 [19]. 
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The MATLAB program implements the MATLAB programming language, and provides a very extensive library to predefined 

functions to make technical programming tasks easier and more efficient.  

MATLAB is a huge program, with an incredibly rich variety of functions. Even the basic version of MATLAB without any 

toolkits is much richer that other technical programming languages. There are more than 1000 functions in the basic MATLAB 

product alone, and the toolkits extend this capability with many more functions in various specialties. 

 

BUILDING SYSTEMS WITH THE FUZZY LOGIC TOOLBOX [21] 

 Although it’s possible to use the Fuzzy Logic Toolbox by working strictly from the command line, it is easier to build 

the system using graphical user interface. There are five primary GUI tools for building, editing, and observing fuzzy inference 

systems in the Fuzzy Logic Toolbox: the Fuzzy Inference System or FIS Editor, the Membership Function Editor, the Rule 

Editor, the Rule Viewer, and the Surface Viewer. The FIS Editor handles the high level issues for the system: for the number of 

input and output variables and also their names. The Membership Function Editor is used to define the shapes of all the 

membership functions associated with each variable. The Rule Editor is for editing the list of rules that defines the behaviour of 

the system. The last two GUIs are used for looking at, as opposed to editing, the FIS. The Rule Viewer is a MATLAB-based 

display of the fuzzy inference diagram. Used as a diagnostic, it can show which rules are active, or how individual membership 

function shapes are influencing the results. Surface Viewer can display how one of the outputs depends on any one or two of the 

inputs- that is, it generates and plots an output surface map of the system. 

The five principal GUI editors all exchange information, if appropriate. Any one of them can read and write both to the 

workspace and to the disk. For any fuzzy inference system, any or all of these five editors may be open. If more than one of these 

editors is open for a single system, the various GUI windows are aware of the existence of the others, and will, if necessary, 

update related windows. 

 

TO FIND THE NUTRIENT DEFICIENCY (NITROGEN) DISEASE OF RICE PLANT: 

   The principal investigator developed the proposed expert system using the graphical user interface (GUI) tools provided 

by the Fuzzy Logic Toolbox. Although it’s possible to use the Fuzzy Logic Toolbox by working strictly from the command line, 

in general it’s much easier to build a system up graphically. There are five primary GUI tools for building, editing, and observing 

fuzzy inference systems in the Fuzzy Logic Toolbox: the Fuzzy Inference System or FIS Editor, the Membership Function Editor, 

the Rule Editor, the Rule Viewer, and the Surface Viewer. These different GUIs are all effectively siblings in that you can have 

any or all them open for any given system. 

 The FIS Editor handles the high level issues for the system The Membership Function Editor is used to define the shapes 

of all the membership functions associated with each variable. The Rule Editor is for editing the list of rules that defines the 

behaviour of the system. The last two GUIs are used for looking at, as opposed to editing, the FIS. They are strictly read only 

tools. The Rule Viewer is a MATLAB-based display of the fuzzy inference diagram shown at the end of the last section. , or how 

individual membership function shapes are influencing the results. It’s a very powerful window full of information. This tool  can 

display how one of the outputs depends on any one or two of the inputs- that is, it generates and plots an output surface map for 

the system. Some of the GUI tools have the potential to influence the others. For example, if you add a rule, you can expect to see 

the output surface change.  

 

GETTING STARTED: 

 The principal investigator scratches again with a basic description of the problem. 

The basic disease of rice plants diagnostic problem. Give a number between 0 and 100 that represents the percentage of symptoms 

of a particular problem arise due to nutrient deficiency (where 100 means fully sure about that symptoms). 

The starting points are to write down the golden rules of diagnosis, based on years of experience of farmers and agricultural 

experts.  

The principal investigator begins working with the GUI tools of MATLAB. When creating a new fuzzy inference system from 

scratch, the place to start is the FIS Editor. To do that, type 

     FUZZY 

 This will call up a window that acts as the high-level (or “big picture”) view of a FIS. At the top of the figure, there’s a 

diagram that shows inputs on the left and outputs on the right. The system that is displayed is a default “start-up” system, since we 

didn’t specify any particular system. 

The purpose of this section of the manual is to build a new system from the scratch. But if you want to save time and follow along 

quickly, you can load the already built system by typing 

    FUZZY RDExpert 

 This will load the fuzzy inference system associated with the file RDExpert.fis (the .fis is implied) and launch the FIS 

Editor. The FIS Editor displays general information about a fuzzy inference system. There’s a simple diagram at the top that 

shows the named of each input variable and each output variable. The sample membership functions shown in the boxes are just 

icons and do not represent the shapes of the actual membership functions. Below the diagram is the name of the system and the 

type of inference used. 
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Figure 2: FIS Editor in MATLAB 

 

 The default, Mamdani-style inference, is what the principal investigator has been describing so far and what principal 

investigator will continue to use for this proposed expert system. There is another slightly difference type of inference, called 

Sugeno-style inference. Below the name, on the left side of the figure, are the pop-up menus that allow the user to modify the 

various pieces of the inference process. On the right side at the bottom of the figure is the area that displays the names of the input 

and output variables. Below that are the Help and Close buttons that call up on –line help and dismiss the window, respectively 

and finally, at the bottom is a status line that relays information about the system from time to time. 

The default system already has one input and one output, but for the proposed system at least seven inputs required. So user has to 

do the following to add four more inputs: 

1. Click the Edit menu. 

2. Select Add variable. 

3. Select input and click to add a new input (add other six inputs). 

4. Select each input and type a give a proper name for each input. 

5. Click once on the right-hand (blue) box marked output1. 

6. Change the name by typing name in the name box at the right bottom part. 

7. From the File Menu select Save to workspace as Disease. 

Enter the variable name disease and click on OK. 

 

Figure 3: Membership Function 

 

 The next thing to do is define the membership functions associated with each of the variables. To do this, the users need 

to open up the Membership Function Editor by pulling down the View menu item and selecting Edit Membership Functions. 

 The Membership Function Editor shares some features with the FIS Editor. In fact, all of the five basic GUI tools have 

similar menu options, status lines, and Help and Close buttons. The Membership Function Editor is the tool that let you display 

and edits all of the membership functions for the entire fuzzy inference system, including both input and output variables.   

 There are no membership functions to start off with. On the left side of the graph area is a “Variable Palette” that lets 

you set the current variable. The membership functions from the current variable are displayed in the main graph. Below the 

Variable Palette is some information about the type and name of the current variable. There is one text field that let you change 

the limits of the current variable’s range (universe of discourse) and another that lets you set the limits of the current plot( which 

has no real effect on the system). In the lower right of the window are the controls that let you change the name, position, and 
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shape of the currently selected membership function. 

1. Make sure the input variable is selected in the Variable Palette. Set the Range to vector [0 100]. 

2. Select Add MFs, from the Edit menu and add four Gaussian curves to the input variable CoopStunted. 

3. Click once directly on the leftmost curve. Change the name of the curve to Low. Also change the parameters listing. 

4. Name the second, third and forth curves as Medium, High and VeryHigh respectively. Also changes the parameters listing. 

5. Same way all the other six input variables are have to create. 

 After creating all the input variables and properly set the parameter listing, next the users need to create the membership 

functions for the output variable, Nitrogen with three membership functions named as No, Maybe and Yes. To display the output 

variable membership functions, Variable Palette on the left have to use. The principal investigator used triangular membership 

function types for the output. First, set the Range (not he Display Range) to [0 100]. The No membership function will have the 

parameters [0 15 30], the Maybe membership function will be [30 45 60] and the Yes membership function will be [60 80 100]. 

So each of these is a fuzzy set entered on the typical number. Your system should look something like figure below: 

 Now the variables have been named, and the membership functions have appropriate shapes and names, the rules can be 

added for the fuzzy system. To call up the editor, go to the View menu and select Edit rules… 

 The Rule Editor contains a large editable text field for displaying and editing rules. It also has some by now familiar 

landmarks similar to those in the FIS Editor and the Membership Function Editor, including the menu bar and the status line. A 

format pop-up menu is the only window specific control- this is used to set the format for the display (figure-4). 

1. In the main (white) text area, type the following rules and then pres Ctrl-Return. 

2.  If (CropStunted is Low) and (LYGreen is Low) and (PlantYGreen is Low) and (FieldCYG is Medium) and (CholoticTip is 

Low) and (LeaveErect is Low) and (Tellering is Medium) then (Nitrogen is MayBe) (1) 

3. If (CropStunted is Low) and (LYGreen is Low) and (PlantYGreen is Low) and (FieldCYG is High) and (CholoticTip is Low) 

and (LeaveErect is Low) and (Tellering is Low) then (Nitrogen is Yes) (1) 

4. If (CropStunted is Low) and (LYGreen is Low) and (PlantYGreen is Low) and (FieldCYG is VeryHigh) and (CholoticTip is 

Low) and (LeaveErect is Low) and (Tellering is Low) then (Nitrogen is Yes) (1)  

Figure 4: Fuzz sets for the certainty of disease presence. 

 The numbers in the parentheses represent weights that can be applied to each rule if desired. If user does not specify 

them, they are assumed to be one. The Rule Format pop-up menu in the lower left indicates that user looking at the verbose form 

of the rules. Not much difference in the display really, but it’s slightly more language neutral, since it doesn’t depend on terms 

like “if” and “then”. If you change the format to indexed, viewer see an extremely compressed version of the rules that has 

squeezed all the language out. 

1 1 1 2 1 1 2, 2 (1) : 1 

1 1 1 3 1 1 1, 3 (1) : 1 

1 1 1 4 1 1 1, 3 (1) : 1 

2 1 1 1 1 1 1, 2 (1) : 1 

2 1 1 2 1 1 2, 3 (1) : 1 

3 1 2 2 2 2 1, 3 (1) : 1 

3 1 2 2 2 2 2, 3 (1) : 1 

 

 This is the version machine deals with. The fist column in the matrix corresponds to the input variable, the second 

column corresponds to the output variable, the third column displays the weight applied to each rule, and the fourth column is 

shorthand that indicates whether this is an OR(2) rule or an AND(1) rule. The numbers in the first two columns refer to the index 

number of the membership function.  

The symbolic format doesn’t bother with the terms if, then, and so o. But the indexed format doesn’t even bother with the names 

of your variables. 

 Now the system has been completely defined. The input variables, membership function and rules necessary to calculate 

nutrient deficiency are set properly. 
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FUZZY NUTRIENT DEFICIENCY DIAGNOSIS: 

 The proposed expert system uses a collection of fuzzy membership functions and rules, instead of Boolean logic, to 

reason about data. The general structure of the proposed expert system can be summarized in the following steps, carried out in 

order: 

Fuzzification:  the membership functions defined on the input variables are applied to their actual values, to determine the degree 

of truth for each rule premise. 

Inference: the truth value for the premise of each rule is computed, and applied to the conclusion part of each rule. This result in 

one fuzzy subset to be assigned to each output variable for each rule. 

Composition: all of the fuzzy subset assigned to the output variable are combined together to form a single fuzzy subset for each 

output variable. 

Defuzzification: is an optional step which is used when it is useful to convert the fuzzy output to a crisp number. The developed 

fuzzy expert system prototype would query the user for the relevant symptoms of rice plants. The strength of each single 

symptom is specified by a fuzzy value such as low, moderate, and high for those symptoms that cannot be measured 

quantitatively like Leave colour or Field colour. 

The prototype proceeds through the above-mentioned inference process and provides a percent value for the certainty of presence 

for each one of the considered nutrient deficiency. 

 

 The developed fuzzy expert system prototype would query the user for the relevant symptoms of rice plants. The 

strength of each single symptom is specified by a fuzzy value such as low, moderate, and high for those symptoms that cannot be 

measured quantitatively like Leave colour or Field colour. 

 The prototype proceeds through the above-mentioned inference process and provides a percent value for the certainty of 

presence for each one of the considered nutrient deficiency. 

Medical diagnosis usually involves careful examination of  rice plant to check the presence and strength of some features relevant 

to suspected disease in order to take a decision whether the rice plant suffers from nutrient deficiency or not. A feature, like a crop 

are stunted, old leaves yellowish green, field colour yellowish green etc. may appear to be very strong for one rice field but it can 

be moderate or even very light for another. It is the experience of agriculture expert that provide the information to the principal 

investigator how to combine a set of symptom (features and their strength) to find out the correct diagnostic decision. 

 To developed the propose system, the principal investigator aim to capture the experience of agricultural experts as well 

as the knowledge of botany and store it in a set of fuzzy tables. Fuzzy inference is employed to develop a computer program that 

can automatically find out the certainty whether the rice field having some specified symptoms suffer from any one of the 

suspected disease. To developed the proposed expert system, the principal investigator consider only nitrogen deficiency disease 

as it the most common disease in the rice fields of kokrajhar and chirang districts of  BTAD. 

 To specify the symptoms of a nutrient deficiency of rice plant, the principal investigator would be checked against all 

features in the set and a fuzzy value would be assigned to each feature. The fuzzy values are selected from the set: 

  {Very Low, Low, Moderate, High, Very High} 

 

FUZZY KNOWLEDGE REPRESENTATION: 

 The experience of the expert system physician regarding the set of considered diseases D is captured in a set of fuzzy 

tables, each of which specifies the profile for nitrogen deficiency disease. The principal investigator consider three fuzzy sets Yes, 

May Be, and No as shown in figure 6.1 to represent the certainty of disease presence. Entries in the disease profile tables would 

be selected from these fuzzy sets. 

 After designing the Fuzzy inference system by using Mamdani inference method of MATLAB, the principal investigator 

use GUIDE of MATLAB for developing user interface from where user access the expert system for input the scale of various 

symptoms, like field colour, Leave colour, Plant colour, etc. The user interface is looking like as show in figure 5 below: 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5:  User Interface 
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CONCLUSION: 

  

 The study has helped to accept the all three hypothesis i.e., it has established the fact that “ The cultivator engaged in 

paddy cultivation are not aware of nutrient deficiency in rice field or soil, and it has also proved that the farmers engaged in paddy 

cultivation are also not aware of the impact of nutrient deficiency as well as proper fertilizer  to be used.” The study has found the 

third hypothesis that “The main nutrient deficiency in the rice fields of Kokrajhar and Chirang district of BTAD is “Nitrogen” 

deficiency.”  

The present study though concerned with exhaustible resources is essentially dealing with socio-economic conditions of the 

people engaged in exploiting exhaustible resource. The people engaged in paddy cultivation are mostly belong poor background 

and they don’t have proper knowledge of nutrients present in the soil as well as soil types. This is a useful study for the farmers 

which help them to understand the soil type as well as the amount of fertilizer to be used. The paddy cultivation provides very 

high income to the farmers. However, these are concealed because of apparently poor type of living style found in these 

communities. The truth of the matter is that due to illiteracy and the strenuous nature of work, much of their income is “spent on 

drinking”. Even women labourers are also addicted to it. The evils of drinking are well known to all. They affect family life, 

economic well being and prospects of the children coming up. Hence there is need for attention of social welfare officers and 

social workers who can pursue these workers to divert their earnings towards the improvement of their living conditions and the 

standard of living.  

Fuzzy Logic is a simple and effective technique that can be advantageously used for diseases diagnosis of a wide range of 

diseases. The principal investigator in this study a methodology to capture the experience of agriculture expert and store it in 

fuzzy tables to represent disease profiles. Simple fuzzy inference techniques can be used to provide sound diagnosis decisions. 
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